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This work is licensed under a Creative Commons Attribution-ShareAlike 4.0 License.  
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This is a collaboration with:

● Brooklyn Public Library
● Metropolitan New York Library Council (METRO)
● New America and London School of Economics
● Data & Society 
● Research Action Design (RAD)

Funded by the Institute for Museum and Library Sciences (IMLS)



Libraries have served a critical role in providing free access 
to the web, especially to underserved populations.

BPL and New America conducted research to understand 
librarian concerns, challenges, and questions about 
digital privacy and security.¹ This workshop was one of 
the recommendations.

Workshop Motivation
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1. For further reading related to this research, see Morrone, M., & Witt, S. (2013). Digital Inclusion, Learning, and Access at the 
Public Library. Urban Library Journal, 19 (1). http://academicworks.cuny.edu/ulj/vol19/iss1/8 and Gangadharan, S. (2015) The 
downside of digital inclusion: expectations and experiences of privacy and surveillance among marginal internet users. 
http://eprints.lse.ac.uk/64156/1/Downside_digital_inclusion.pdf 



Workshop Goals
● Digital privacy and security practices to share with 

patrons
● Assess and communicate privacy risks with patrons 
● Protecting accounts with strong passwords and 

2-factor authentication
● Hands-on internet browsing privacy controls & tools
● Malware and virus prevention and protection
● Resources and practices available to library 

institutions
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Workshop Agenda
■ Introductions
■ Risk Assessment
■ Passwords, 2-Factor Authentication & Password 

Managers

Break (10min)

■ Privacy on Public Networks and WiFi
■ Browsing Privacy and Anonymous Browsing
■ Malware
■ Review & Eval
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Introductions
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Risk Assessment
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Risk Assessment: Questions

1. What information do you want to keep private?
2. Who might try to access that information without 

your consent? How likely is it that they will succeed?
3. What are you already doing to keep it private?
4. What are the consequences and how impactful 

would the consequences be for you?
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Risk Assessment Report back
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Passwords
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How strong is your password?

https://password.kaspersky.com/ 

Test: Try a password you think would be good

But, Don’t use your own password
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Strong Passwords from Phrases

She was more like a beauty queen from a movie scene 

→ SWMLABQFAMS

→ $wml@BQf@m$

You can also use a long sentence (but NOT common):

Silver socks float around rivers
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Library PINS

Do’s Dont’s

- Information of a person other 
than you (ex. last 4 of your 
childhood friend’s phone 
number)

- Modify personal information (ex. 
birth year backwards)

- Have the patron enter their own 
PIN

- Personal information birthdate 
MMYY MMDD

- birthyear (ex. 19xx or 20xx)
- Other personal info: last 4 of SSN, 

last 4 of your phone number
- sequential digits (ex. 1234)
- repeated digits (ex. 7777)
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2-Factor Authentication
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2-Factor Authentication

Something I KNOW
 & 

Something I HAVE
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Hands-on: 2-Factor Authentication 

https://www.google.com/landing/2step/ 

http://twofactorauth.org

YOUR BANK GMAIL
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Device Passwords & Encryption

You should also put a password on your 
personal computers and mobile devices like 

smartphones and tablets.
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Password Managers
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Demo: Password Managers
Demo: LastPass

https://lastpass.com
/

Other Password Managers

● Dashlane, https://www.dashlane.com 
● KeePass, http://www.keepass.info
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Password Takeaways
● Create UNIQUE passwords for the most sensitive 

accounts
● Change passwords every 6 months
● Use a LONG password (more than 12 characters)
● DO NOT include anything obvious (your birthday)
● CAREFUL of phishing
● Use 2-factor authentication
● Use a password manager to store complicated 

unique passwords
● DO NOT store passwords in browsers! 
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BREAK
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Privacy on Public Networks & Wifi 
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BPL’s WiFi EULA
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HTTP vs. HTTPS

Image source: http://binaire.blog.lemonde.fr/page/7/

vs.
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HTTPS Pledge

1. We will make every effort to 
ensure that web services and 
information resources under 
direct control of our library will 
use HTTPS within six months. [ 
dated______ ]

2. Starting in 2016, our library will 
assure that any new or renewed 
contracts for web services or 
information resources will 
require support for HTTPS by the 
end of 2016.

1. We will make every effort to ensure 
that all web services that we (the 
signatories) offer to libraries will 
enable HTTPS within six months. [ 
dated______ ]

2. All web services that we (the 
signatories) offer to libraries will 
default to HTTPS by the end of 2016.

1. We will make every effort to 
ensure that all web services 
that our organization directly 
control will use HTTPS within 
six months. [ dated______ ]

2. We encourage our members 
to support and sign the 
appropriate version of the 
pledge.

Library Freedom Project: 
https://libraryfreedomproject.org/ourwork/digitalprivacypledge/

The Pledge 
for Libraries:

The Pledge for 
Service Providers 

(Publishers and Vendors):

The Pledge for 
Membership 

Organizations:
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Digital Fingerprints
What is my fingerprint? Go to:
● https://www.whatismybrowser.com/ 
● https://panopticlick.eff.org and click “Test Me”
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VPN
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How a VPN works
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VPN Demo 

https://www.privateinternetaccess.com
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VPN features and services

Some VPN Services

● Private Internet Access, for fee, 
https://www.privateinternetaccess.com

● Riseup VPN, free, https://help.riseup.net/en/vpn for 
Linux, Android and Microsoft Windows

● Psiphon, free, https://psiphon.ca, Microsoft 
Windows and Android.

● Your Freedom, free, http://your-freedom.net/, and 
pay for Linux, Mac OS and Microsoft Windows
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Anonymous Browsing with Tor: Demo

https://www.torproject.org
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Network Privacy Takeaways
1. Only login on secure sites using encryption: HTTPS

2. Don’t use the same username and password for 
different sites

3. Save the most important tasks for home or secure 
private connection (ex. your own hotspot).

4. Maximum Security: Use a VPN
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Browsing Privacy

Browser settings, Tracking and 3rd Party Services
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Privacy and Browsing

comic by Gegen Den Strich, gegen-den-strich.com

Who am I on the internet?
● My browser & browser cookies
● My accounts when I’m logged in
● My fingerprint

Hands-on with Internet Privacy
● Browser settings
● Actively blocking tracking
● Opting out of tracking
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What does your library do? 

Library browsing privacy: BPL’s computer terminal reset. 

When a patron’s session ends or they log off:

● Clear Browser Data including browsing history, form 
data, user and passwords;

● Clear downloaded files;
● Clear temporary files;
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What Browser are you using?

We recommend….
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What are cookies?

Wall Street Journal Video: How Advertisers Use Internet Cookies to Track You
https://vimeo.com/12204858
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What is Private Browsing Mode?
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Hands-on: Bye Cookies & History
View cookies, How To: 

http://www.wikihow.com/View-Cookies

Delete the browsing history and cookies

a. Chrome: Preferences>History>Clear Browsing 
Data>Select all from Beginning of Time

b. Firefox: Menu Button(    )>History>Clear Recent History
c. IE: Tools> Safety> Delete Browsing History, Select 

Cookies checkbox and click Delete
d. Safari: Safari>Preferences>Privacy>Remove all website 

data
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Mobile Browser Privacy Settings
Mobile browsers offer settings:

● Cookie and History Deletion
● Private Browsing
● “Do Not Track”
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Hands-on: Disable Flash
Chrome: Preferences>Settings>Content 
Settings>Plugins>Individual Plugins

Firefox: Tools>Add Ons>Shockwave Flash (Ask to activate)

Enabling Flash on specific sites. http://hulu.com
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Plugins to prevent Third Party Tracking
Hands-on with the Privacy Badger Plugin

Go to: https://www.eff.org/privacybadger

Chrome or Firefox

Other similar plugins: 

● Disconnect, https://disconnect.me/
● Adblock Plus, https://adblockplus.org/
● Ghostery, https://www.ghostery.com/
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Social Media Privacy Settings
Let’s look at some 
settings:
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Privacy in Browsing Takeaways

BPL automatically mimics “Private Browsing” mode on 
logout by deleting history, form data, and 
usernames/passwords;

Steps we can take:

● Browser settings: Deleting history and cookies, 
Private browsing

● Opt-Out of some Tracking
● Using a diversity of software providers
● Block and prevent some Tracking using plugins
● Anonymous Browsers and Anonymous VPNs
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Malware
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Anti-malware software
Other popular software:

● AVG, http://www.avg.com/ Avast, 
https://www.avast.com/ - Free  
trials, scan & cleanup;

● Kaspersky, kaspersky.com - Free 
scan and cleanup;

● Malwarebytes, malwarebytes.org - 
Free scan and cleanup;

● Norton, norton.com - Free trials; 
● Sophos, sophos.com - Free tools 

for home use (click “Free Tools”)

BPL’s anti-malware practice: 

● McAfee Antivirus 
Enterprise, mcafee.com - 
Windows

● Gatekeeper, Macs
● Update virus protection 

daily; scan computers and 
files
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Turn on your Firewall

Mac: Apple Menu>System Preferences>Security & 
Privacy>Firewall

Windows: 

● In Search, type “firewall”, and then select Windows 
Firewall.

● Select Turn Windows Firewall on or off. You might 
be asked for an admin password or to confirm your 
choice.
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Update your software!
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Avoid Phishing & Click Bait
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Mobile Antimalware
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Anti-malware Takeaways
● Backup! Make a copy of your computer files and programs on an 

external drive.
● Update your software including your Operating System (OS);
● Be careful of links and downloads. Research the best app for the job. 

Don’t follow unknown links or download unknown attachments; scan 
files if you don’t trust them; be careful in granting permissions (mobile)

● Screen for Malware. Install and use Antivirus/Antimalware software on 
your personal computers to scan your computer and suspicious files;
○ BPL scans using Antivirus/Antimalware software on all of its 

computers;
● Tell people if they send you malware;
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Revisiting Your Risk Assessments
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dataprivacyproject.org

Review: http://www.dataprivacyproject.org/mapping-data-flows/#login    
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Thank You & Exit Survey!

Please complete the Exit Survey!

Project website: http://dataprivacyproject.org

For more information about the project, email 
dataprivacy@bklynlibrary.org. 
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